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! Field-programmable Gate Array
2 Integrated Synthesis Environment
3 Complex Programmable Logic Device
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e Microsoft Windows 10 (32 and 64 bits)
e SUSE Linux Enterprise 11 (32 and 64 bits)
o Red Hat Enterprise Workstation 4, 5, and 6 (32 and 64 bits)
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ISE 14.7 Installer - X
A Welcome
’ We are glad you've chosen Xilinx as your platform development partner. This program will install ISE
\ design environment, Software development kit or Lab tools.

You will need to have administrator privileges in order to install this software on Windows operating
systems.

For the product you select to install, we recommend that you identify a directory that does not
contain an older installation of the same product version.

Mote - To reduce installation time, we recommend that you disable any anti-virus software before
continuing
ISE 14.7 Installer

-> Welcome
Accept License Agreements
Select Products to Install
Select Installation Options
Select Destination Directory

Installation

Copyright (c) 1995-2013 Xilinx, Inc. All rights
reserved,

XILINX, the Xiinx logo and other designated
brands included herein are wrademarks of Xilinx,
Inc. Al other wademarks are the property of
their respactive owners.
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ISE 14.7 Installer

- X
“ Accept License Agreementis (1 of 2)
' Please read the following terms and conditions and click the checkbox below it to indicate that you
\ accept and agree.
XILINX, INC. E‘
END USER LICENSE AGREEMENT
CAREFULLY READ THIS END USER LICENSE AGREEMENT ("AGREEMENT"). BY CLICKING THE
"ACCEPT" OR "AGREE" BUTTON, OR OTHERWISE ACCESSING, DOWNLOADING, INSTALLING OR
USING THE SOFTWARE, YOU AGREE ON BEHALF OF LICENSEE TO BE BOUND BY THIS
AGREEMENT.
ISE 14.7 Installer IF LICENSEE DOES NOT AGREE TO ALL OF THE TERMS AND CONDITIONS OF THIS AGREEMENT,
DO NOT CLICK THE "ACCEPT" OR "AGREE" BUTTON ORACCESS, DOWNLOAD, INSTALL OR USE
Welcome THE SOFTWARE; AND IF LICENSEE HAS ALREADY OBTAINED THE SOFTWARE FROM AN
. AUTHORIZED SOURCE, PROMPTLY RETURN IT FOR A REFUND.
-> Accept License Agreements
Select Products to Install 1. Definitions
Select Installation Options
Select ination Di v “Authorization Codes™ means any FLEXIm license key, license file, license manager, dongle or other
Installation key, code or information issued by (or on behalf of) Xilinx that is necessary to download, install, operate
andior regulate User access to the applicable Software. _|
-

¥ Waccept and agree to the terms and conditions above

v Jalso accept and agree to the following terms and conditions

1 also confirm that I have read Section 13 of the terms and conditions above concerning WebTalk and have been afforded
the opportunity to read the WebTalk FAQ posted at http: //www.xilinx.com/ise fwebtalk/. Iunderstand that I am able to
rEssves disable WebTalk later if certain criteria described in Section 13(c) apply. If they don't apply, I can disable WebTalk by
)S:In::‘ “mlme?;: ':mde:?mm uninstalling the Software or using the Software on a machine not connected to the internet. IfI fail to satisfy the

In. All other ademarks are the propenty of applicable ariteria or if I fail to take the applicable steps to prevent such transmission of information, I agree to allow Xiinx

Copyright (c) 1995-2013 Xiinx, Inc. Al rights

their respective owners. to collect the information described in Section 13(a) for the purposes described in Section 13(b).
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ISE 14.7 Installer - X
< Accept License Agreements (2 of 2)
’ Please read the following terms and conditions and click the checkbox below it to indicate that you
‘ accept and agree.
CAREFULLY READ THIS COLLECTION OF INFORMATION AND LICENSE AGREEMENTS. BY g
CLICKING THE "ACCEPT" OR "AGREE" BUTTON, OR OTHERWISE ACCESSING, DOWNLOADING,
INSTALLING OR USING THE SOFTWARE, YOU AGREE ON BEHALF OF LICENSEE TO BE BOUND BY
THIS INFORMATION AND LICENSE AGREEMENTS (TO THE EXTENT APPLICABLE TO THE SPECIFIC
SOFTWARE YOU OBTAIN AND THE SPECIFIC MANNER IN WHICH YOU USE SUCH SOFTWARE).
IF LICENSEE DOES NOTAGREE TOALL OF THE INFORMATION AND LICENSE AGREEMENTS
BELOW, DO NOT CLICK THE "ACCEPT" OR "AGREE" BUTTON ORACCESS, DOWNLOAD, INSTALL
1ISE 14.7 Installer OR USE THE SOFTWARE; AND IF LICENSEE HAS ALREADY OBTAINED THE SOFTWARE FROMAN
AUTHORIZED SOURCE, PROMPTLY RETURN IT FOR A REFUND.
Welcome . .
-> Accept License Agreements Part One: Overview.
Select pm’"m‘m l"ﬂ_’" The following information applies to certain items of third-party technology that are included along with
Selact nstallation Options certain Xilinx software tools.
Select Destination Directory
Installation The Xilinx Embedded Development Kit (EDK) is a suite of software and other technology that enables
Licensee to design a complete embedded processor system for use in a Xilinx Device. EDK includes,
among other components, (a) the Xilinx Platform Studio (XPS), which is the development environment,
or GUI, used for designing the hardware portion of an embedded processor system; and (b) the Xilinx
Software Development Kit (SDK), which is an integrated nent envi , compl yto
XPS, thatis used to create and verify C/C++ embedded software applications. SDK is also made
available separately from EDK.
z";’:ﬂm (9 19952013 X, Inc. Al rights Licensee's use of the GNU compilers (including associated libraries and utilities) that are supplied
XILINX, the Xiinx logo and other designated | With SDK may cause Licensee’s software application (or board-support package) to be governed by Ll
brands inchuded herein are ademarks of XHin, Jage 4 =ie Aieat o o k. Se @ m — mesmm B B mmm = —tm 2 m i o Eormbl 2 2 oot m & ke hmns 1 Eommmmm mme maraiat
mw&wm‘ e e [ ) accept and agree to the terms and conditions above
.
<Back |  MNet> |J) cCancel
e
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ISE 14.7 Installer - s

Select Products to Install

’ = Edition List
\ 1+ ISE WebPACK
" ISE Design Suite Logic Edition

" ISE Design Suite Embedded Edition
" ISE Design Suite DSP Edition

" ISE Design Suite System Edition

ol

Lab Tools - Standalone Installation

ISE 14.7 Installer

Welcome Disk Space Required : 17480 MB
Accept License Agreements
-> Select Products to Install
Select Installation Options — Description of ISE WebPACK
Select Destination Di v
Installation ISE WebPACK contains the most important tools you need for designing CPLDs and small to

medium-sized FPGAs. Includes: ISE Design Tools (w/reduced device support), PlanAhead,
Connectivity DSP IP. ChipScope Pro and The Embedded Development Kit will also be installed
with WebPACK but are licensed separately (not included in a WebPACK license file).

Copyright (c) 1995-2013 Xilinx, Inc. All rights

reserved,
XILINX, the Xilinx logo and other designated
brands inchuded herein are rademarks of Xilinx,
Inc. All other vademarks are the property of
their respective owners,
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ISE 14.7 Installer

- X
. Select Installation Options
’ Select the desired installation options below. Selection of these options may result in additional
‘ programs being run at the conclusion of the installation process.
se multiple CPU cores for faster installation
Enabling this option wiill speed up installation but may slow down other active applications.
Acquire or Manage a License Key
Install WinPCap for Ethernet Hardware Co-simulation
[ Install Cable Drivers
ISE 14.7 Installer
Welcome
Accept License Agreements 4| | »
Select Products to Install

-> Select Installation Options

Select/Deselect All
Select Destination Directory

i Description of Acquire or Manage a License Key
Installation

Most Xilinx applications now require a license key file in order to run. If this selection is enabled,
the Xilinx License Configuration Manager will be opened in order to assist you either in acquiring
a new license file or in managing an existing license file. If this is your first time using Xilinx ISE

Design Suite 14.7, it is highly recommended that you use this application to acquire or install
your license file.

Copyright (c) 1995-2013 Xilinx, Inc. All rights
reserved,

XILINX the Xiinx logo and other designated
brands inchuded herein are trademarks of Xilinx,
Inc. All other trademarks are the property of
their respective owners.
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ISE 14.7 Installer - X

CISE

< Select Destination Directory

Select the directory where you want the software installed.

| c:ilinx | Browse...
Install location(s) :
C:\Xilinx\14.7\ISE_DS
Disk Space Required : 17480 MB
Disk Space Available : 163993 MB
ISE 14.7 Installer

Welcome

Accept License Agreements

Select Products to Install

Select Installation Options ¥ Create Start Menu and Desktop Icons

> Select Destination Directory Select a Program Folder

Installation
This name will appear in the Start Menu > Programs list.
|X|‘Iimc Design Tools j

W Tool preferences and file association

Import tool preferences from previous version and change project file association to ISE WebPACK 14.7

Copyright (c) 1995-2013 Xiinx, Inc. All rights

reserved.

XILINX, the Xilinx logo and other designated
brands inchuded herein are rademarks of Xilinx,
Inc. All other rademarks are the property of

their respective owners.
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ISE 14.7 Installer
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ISE 14.7 Installer
Welcome
Accept License Agreements
Select Products to Install

Select Installation Options
Select Destination Directory
-> Installation

Installation
Options Summary

Install Location(s):
C:\Xilinx\14.7\ISE_DS

Edition : ISE WebPACK

Program Group: Xilinx Design Tools
Option: Acquire or Manage a License Key

ISE DS Common

Install Location: C:\Xilinx\14.7\ISE_DS\common

Module: ISE DS Common

Option: Script to install VC++ runtime libraries for 326t 0S
Option: Script to install VC++ runtime libraries for 64-bt 0S

EDK

Install Location: C:\Xilinx\14. 7\ISE_DS\EDK
Module: EDK

Option: MB Linux Toolchain postnstall

PlanAhead Analysis Tool

Install Location: C:\Xilinx\14.7\ISE_DS\PlanAhead
Module: PlanAhead Files

Option: setupEnv bat

ISE

Install Location: C:\Xilinx\14.7\ISE_DS\ISE
Module: Design Environment Tools

Module: WebPACK Devices

Option: Install WinPCap for Ethemet Hardware Co-simulation

m’" 19 SS213 Shex Roc AN gl Option: Install Windows System Generator Info XML

XILINX, the Xiinx logo and other designated | Option: Install Cable Drivers

brands inchuded herein are trademarks of Xiliny, | Option: Enable WebTalk to send software, IP and device usage statistics to Xilinx (Always enabled for WebPACK license)
Inc, All other rademarks are the property of
their respective owners.
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ISE 14.7 Installer [ 86% ] = X

< ISE DS Common:

’ Script to install VC++ runtime libraries for 32-bit 05

By UL DL DL LT 86%
ISE 14.7 Installer

Welcome Accelerate Productivity with Xilinx Targeted Design Platforms

Accept License Agreements

Select Products to Install

Selact Inscallation Options > Xilinx development kits provide out-of-the box solutions that significantly

Select Destination Directory

cut development time and enhance productivity. Xilinx takes it one step
further with targeted design platforms - the industry’s most comprehensive
development kits.

-> Installation

Copyright (¢) 1995-2013 Xiirx, Tnc. Al rights www.xilinx.com/kits XI LI NX
reserved.

E PROGRAMMABLE.
XILINX, the Xilinx logo and other designated 5

brands inchuded herein are trademarks of Xilinx,
Inc. All other trademarks are the property of
their respective owners,
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i: Xilinx License Configuration Manager

Acquire a License Borrow/Restore Licenses Return Licenses I Internet Settings

Instructions: Click the “Load License” button to either load a response XML file into XLCM to activate your machine for Xiinx tools and IR or copy a

certificate-based license (.iic file) into the local Xilinx directory. Xiinx applications automatically detect vaiid, node-locked licenses (* i) residing in the
local Jilinx directory.

<

To peint to a floating server license, or to point to license files in locations other than .Xilinx, set one of the environment variables below. (Linux users

will need to make these settings outside of this application.) Examples: 1234@server;C:\licenses\)ilinx.lic (Windows) or 1234@server:/usr/local/flexdm
(Linux)

XILINXD_LICENSE_FILE |

=1
LM_UICENSE FILE |
HIDDEN ¥ Hide Built-in Fres Licenses Clear Cache
Information ﬂ

Feature S/W or

IP Core

Version
Limit

License
Type

Expiration
Date

Count Licenses

In Use

\ =]

Local System Information

Hostname: ALI-DESKTOP
Network Interface Card (NIC) ID:

C: Drive Serial Number:

FLEXID Dongle ID:

oo e
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<install_path>\Xilinx\14.7\ISE_DS\ISE\lib\nt64\

Jeas 55 “libPortability.dll.orig” « |, “libPortability.dIl” |, ol =Y
s 13 “libPortability.dll” 1, ol (’U 5058 sbwl S K “libPortabilityNOSH.dII? b 51 v
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<install_path>\Xilinx\14.7\ISE_DS\common\lib\nt64\
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& ISE Project Navigator (P.20131013) - CAXilinx\Project1\ProjectT\Project1.xise - [Design Summary] - a X
L File Edit View Project Source Process Tools Window Layout Help - & x
03 HD Xwa| = AR RIARETID SR PV
o = woex] Du%\ l;f.c":.::y D Module1. Project Status
d ) El 0] Svn.bv- Q ] ertie Project File: Project].xise Parser Errors: No Errors
&l - ] M tilizats Fodube Hame: Module1 Amplemantation State: Mew
G| | 8] Proiectt Tormt Do e —
S (O xctishid-3tqgl4d 3 .
oral (Mo ¢ 3 Product Version: 152147 + Warnings:
L @ static Timing Design Gosk: eaanced * Routing Resuks:
4] ga| © Eromand Warmings o ik o Tt
[B) Parser Messages
N Sortheci Messan Final Timing Score:
< “
- B Do ad B Def . (S}
u_.‘»l,b So 3 Timing Message statue — DS L23 T armings =
i B an fessoges Syrthass faport
< Y =i Detailed Reports Transistion Report
h| t Report Map Repot
P [ 22 o Procsmmss e Place and Route Report
' | Processes: Modulel - Behavioral Povwer Report
o} L Design Summary/Reports w | ]| Post-PAR Statc Timing Rapont
Design Utilties S =]
Stgen Report
L@ User Constraints Design Properties
—|® 28 Synthesize-xsT [ Enable Message Filtering
5 £ Implement Design Optional Design Summary Contents -
£ Generate Programming File [ Show Clock Report [ ) L}
© @  Configure Target Device [ Show Failing Constraints | Report Hame Status [ canarated
Analy Design Using ChipS: Show Wamings
laas | P So
# ot B3 Degn W) P ) o | T Design Summary [x]
—
Conscie EBEEE
Launching Design Summary/Report Viewer... P

) INFO: HDLCompiler:1061 - Parsing VHDL file "C:/Xilinx/Projectl/Projectl/Modulel.vhd” into library work
§)INFO:ProjectMgme - Parsing design hierarchy completed successfully.
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Al LY S et Sl Ol 1 ey S Ol | “New Project” e 5§

&  NewProject Wizard

Create New Project

Specify project location and type.
Enter a name, locations, and comment for the project
Mame: Full_Adder

Location: C:\Xilinx\Project1\Ful_Adder

Working Directory: | C:\Xilinx\Project1\Ful_Adder

Description:

ECE. University of Sistan and Baluchestan

Select the type of top-level source for the project
Top-level source typs:

HDL ~

=

23sn o pd Jome 5 b il MY IS

S bl s ge5s sl pb S :Name

S yasiia |y 0)s (o3 ol lLocation

S s Agls 1y 35 (G055 s b sled 5 adsile 03 S s | dad oS glad 5 sl Working Directory
(ol O 3 2sn 3T b Y game adg cpl e2])

Aol 3ol Caand pl 3 59 655”;74{@-\) Sl 5 Gl o se > (Description
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New Project Wizard

Project Settings

Specify device and project properties,

Select the device and design flow for the project

Property Name Value
Evaluation Development Board None Specified
Product Category All

Family Spartanb
Device XCBSLX4
Package TQG144

Speed -3

Top-Level Source Type
Synthesis Tool

HDL
XST (VHDL/Verilog)

Simulator 1Sim (VHDL/Verilog)
Preferred Lanquaae VHDL

Property Specification in Project File  Store all values
Manual Compile Order O

VHDL Source Analysis Standard VHDL-93

Enable Messaqge Filtering O

More Info

oj\jj.; LSM,Li Slasin ul;::.u‘ AY JS.&

! Schematic
2 HDL: Hardware Description Language
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(B G 5oy skmann Jls Olse a) A0S Obssl | 555 gadl 5 susaws (Product Category

S el Gl s ) B s se el gesl 5l (Family

S Obnl | ail 5 58s gawlis :Device

S jasia |y adl 3 gduanas kL (Package

S Ol |y adl 5 se e (e, :Speed

Al eis BB 5 S jasie |3 o 5 &S s el 0 SYL (o 5 (5o s TOP-Level Source Type
Aales ol dyls 1 O 5l eslizal das a5 g 5o 15 :Synthesis Tool

5P ModelSim L 5 Xilinx s 5 51 1SIm e s Jls Ol ge 4) S Obsl | 555 (go55, 3l and :Simulator
(Mentor Products s,

Aoas pll O S aly Co s Al oo 45 L5 ‘Preferred Language

g ot lad o5, LU so ol 5l s pliS &S S a5 PrOpETTY Specification in Project File

S S oy Gileand s e gl bdgil Cole ekl dal s &S 5550 s :Manual Compile Order
S Ol a8 ol S aside

S asie cdyls | O sl eslizal das 45 VHDL oL s luskewl :VHDL Source Analysis Standard

o5 e OLES |y o5 sloml gy o lad glaobinl gawdt a5 S sl (glasin 3l CNext” uJs s 25 L
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& |SE Project Navigator (P.20131013) - EMNISE Projec

File Edit View Project Source Process

RE-ASEE, # DD X0 o
\ Design +08& X
(i7)ve ® {8} 1mplementation O [l Simulation
| | Hierarchy a

| € Full Adder
= £ xcbsix9-2tqgl4d

Empty View

e The view currently contains no files.
You can add files to the project

- using the toolbar at left, commands
7 from the Project menu, and by
using the Design, Files, and
Libraries panels.

Use:

= New Source: To create a
new source file.

» Add Source: To add an v

o555 Sl A source G ol VY S

! Test Bench
2 Implementation Constraints File
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LS Ko L aars bl dd dal ol il lad gl V8 G o2y (558 g5 bl Sl
“Full_Adder” oU o0 g b 5550 dgdle s a5 b oS 005 Ol o ob SSSOUMCE (ol (6, b e oS o

AL s ld Olss) “Add to project” ga 5§ Lu 45 A3l anils ax 5 54 Al

& New Source Wizard pd

- Select Source Type
Select source type, file name and its location.

<7 IP (CORE Generator & Architecture Wizard)
Schematic

User Document
Verilog Module

)| Verilog Test Fixture
VHDL Medule
VHDL Library
VHDL Package | Ful_adder |
3] VHDL Test Bench ]

%% Embedded Processor Logation:

E:\ISE Projects\Four_Bit_Adder

File name:

@gdd to project

More Info Next = Cancel

(dsile g 3D ol @Sl s source ¢ 5 bl Vg JSS

sl ol J5le S source g5 o Jd sl e 5o Sl wam g L Al A (a4 “NeXt” WS o i L
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o New Source Wizard >
- Define Module
Specify ports for module.
Entity name  Ful_Adder
Architecture name  Behavioral
Port Name Direction Bus MSB LSB o
in v [
in v []
in ~ [
in v [
in v [
in v [
in ~' [
in v [
in v
in v [] v
More Info < Back Next > Cancel

ol J s Jglle glac, g 058 jaia N0 JSS

-L:-ls-l.;.?l.! Sy see 3l dalet onls oles e 4y ol sl SOUMCE 31 (laods day (Gammin )3 amein oyl ) JRtge
b e ey 4 ol Lb source sl 5l ey 355 wilsl o5, a5 sl L 5, 50 SOUICE U UoS bl |, “Finish”
0 oL SOUMC sl 31 Ly oS 555 a5 .S 5L 1, OF il e OF (s SIS S 5o L oS ds dalgr bl o)y
OV JSE) S o b Cho 5w 3 Al e 5 A dal L S s

Gl a5 oS Sl e (g3lwand 5 le3T SOUNCE 5 S dual st iy 55 OF 4 Yleas| 45 SOUMCE (ps 5
oS 2 038 OF 51 3es 5 L dal g o3ls s Bl om0 O 5l eslinal 5 sl (go s (A i) (g5l
ALl edee O 3 Shas oo 5l Sl 5 3185 Glagsle 4t SaS 4 5 L8 pll 2 b i 5 oSST )
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& ISE Project Navigator (P.20131013) - EAISE Projects\Four_Bit_Adder\Four_Bit_Adderxise - [Full_Adder.vhd] - a
[2) File Edit View Project Source Process Tools Window Layout Help - & x
02 Ha| % Xwa| = fPRR RIAM RT3 FR:PIL:Q
Desgn «+0 & x§y -
| en: ® {58 implamantitbon O ] swisson ],
3] | Hierarchy
2 ] Four_Bit_Adder
= 0O xchshd-2qgldd _—
7 [l [Fuil_Adder - Behavioral (Full_Ad)
&
a 4
F e
= I
“
&
o
< >
P | B) o Processes Running
71, | No single design module is selected.
2| @ @  DesignUtilities
A
32 entity Full_Rdder is
33 end Full hdder:
34 g
< >
B Ful_Addacvhd [ 1k Dasign Summary
—
Conscls ~0 8 x

Started : "Launching ISE Text Editor to edit Full Rdder.vhd".
Launching Design Summary/Report Viewer...

<

[8 consce @ Eron I\ wamngs B4 Findin Fes Rasuts

Ln1Col1 VHDL

Jslle o s 4 g0 AT K2

& New Source Wizard

€-Select Source Type
Select source type, file name and its location.

[ BMM File
E® Implementation Constraints File

MEM File

Schematic

User Document
Verilog Module
Verilog Test Fixture
VHDL Module

VHDL Library

VHDL Package

VHDL Test Bench
Embedded Processor

€* ChipScope Definition and Connection File

IP (CORE Generator & Architecture Wizard)

Fie name:

[ Ful_adder_icf

Location:

E:\ISE Projects\Full_Adder

@

(3lmosly yssdomn ¢ 5 51) ol (5,138, s source g bl IV S
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53 deles bl 1 “RUN a8 5 03 S Conly SIS (VA IS8 e Lga.ijf‘_;))ﬁ.).;ibé Gooey 53 e - dmled

Al o a5 el lns a0 5w g 0B L 2L S5 4 e

CQ No Processes Running

Processes: FA1 - full_adder_vhdl_code - gate_|
p:> Design Summary/Reports

IEELR

o Design Utilities

V| @ %  User Constraints

— | @ #)  Synthesize - XST <«
# €2  Implement Design

)  Generate Programming File
Configure Target Device
€4+ Analyze Design Using ChipScope

&

J;ifjsdam)zcjlo};.ﬂ.\/\‘)sb

sl bl e lea Top Module o 5e 4 source of LU source G (gilwesly 5yt (gl oS il axdls L 5o
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» (] No Processes Running

?{: Processes: FA1 - full_adder_vhd|_code - gate_|
& | & %  Design Utilities

: )  Create Schematic Symbol

A [£]  View HDL Instantiation Temp...
C— )  Check Syntax

Top Module ,.& source (sl 15 o, N4 K

505,5 cul, SIS source of g5, — Y JS—s sLke Top Module ol e . source S oLzl gl —
cpdaer oS cul gl an by e Lgs Top Module p_@_an) Aol Ol |, “Set as Top Module” gas 5§

(.L..I;L; il 3459 Lo Cjb BE JJ‘BL& Cf ) source

Design «+0&8 x , | = Dey
[ | Yiew: ® B 1mph son O -
:.Cf] Hierarchy o
:[H ﬁ Four_Bit_Comparator_Using_Adder 9
— | = €3 xcbsk9-2tqgl4d ¢
unn =8 [ Four BitComeoarats
Q ‘-' £| Add Source... r
‘ [ [§z] Add Copy of Source...
[ i
B Fou Res
4=| Remove
Manual Compile Order
% Setas Top Module h
= SmartGuide... <
PR e o P Implement Top Module
71 | Processes: Four_Bit File/Path Display 4
B[® ¥ Desionl  pgang .
)  CheckS n
2 Collzpse All q
m 4 Find... Ctrl+F :fl‘
Design Properties... 0
[#] Source Properties... 1

Top Module ¢l ye 4 source G sl Y S
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5> il IS5 53 4 ISE i3l 5 s Netlist .ol sdd ans 5l losin cheo 5 S0l 5l SC a O1 85 &S o

(SIAFS Sl 5 ol Ul e Solad il 2
(SHH5SS Kbz 53 S Jm s s e ools Gl L Bl 0l b (ol Ji pla o Sl s
(43 8 Sbatl 63s, Cotle il 53 o glad 15,8 L) CPLD L FPGA (sei |5 &G 55 2 b oodls 3lo ooy
SaS 4 885 b O el o 2 LUT (sls 2 FPGA G (6l b ST4S me cpl 4 s dal g ols b
5 S FPGA (55,5 5 e olwesly 31 —ilad (65580 Sl a5 S a8 55 0 5lwenly W LUT
Slosly ol 45 ol ok asiia g5 aSh o o3 ol 0T (S35 2 bt 5 oot cbe o AL Lo 3

ols Vel ax by mbie a4 5L
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(N JKE) A4S SIS L 9 06 ks 5 50 SSla £ Gao 2 o 238 03l Juled el 6l 2l

P> | € No Processes Running

Processes: full_adder_vhdl_code - gate_level
) Design Summary/Reports
+ Design Utilities
User Constraints
Synthesize - XST
View RTL Schematic
View Technology Schematic
Check Syntax
)  Generate Post-Synthesis Sim...
# €2  Implement Design
€2  Generate Programming File
¥ ‘-é Configure Target Device
€%  Analyze Design Using ChipScope

1|89 |55 5

e 31 e C)’ Netlist 2.l YY) &
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& Set RTL/Tech Viewer Startup Mode x

Select how the RTL/Tech Viewer behaves when it is initially invoked
Startup mode

—* (O Start with the Explorer Wizard

In this mode, the Explorer Wizard is the initial screen, and allows
you to select the elements that you want to see on the initial
schematic

—* (® Start with a schematic of the top-level block

In this mode, the Explorer Wizard is bypassed and an initial
schematic is created with only the top-level block displayed. You can
then use the logic expansion capabilities of the Viewer to start
expanding from the top-level block

You can also change the startup mode by selecting Edit->Preferences under
the RTL/Tech Viewer page

Show this dialog on startup

Soled Sl g5 sl XY S

4.:\) CJJ;)‘ Lfnu&.}u w‘&“};“\? odaline 4@‘0&&«?-(@ L,<.: 6‘JJ4SYYJJ§~:'4JL;.A AJJ[S R
SIS DL 53 i 0T s il oo sl 51 GSG 52 05,5 5L 5 0 5383 Sl i SHb S Do
S

full_adder_vhdl_code:1

Mxor_S1

Mxor_A_B_XOR_1_o1

Mxor_A_B_XOR_1_o1

full_adder_vhdl_code

Ful_Addenvhd P Design Summary (Synthesized) | full_sdder_vhdl_code (RTL2) [x]
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2> b el 5L G plaS 48 S Ol B 5 e el 0L L (6,503 (semin (Jsl 54y S Sl e 3 Ll
Solad 53 Al 3L aS 1) il 51 plaS e Ol ol 6l (b ey s b U plS) s sl hled Solas
3 S Lol Sled 0 1 Lol “Add > WS 03,235 L 503 S Ol (Y8 JK8) o e 31 53 0305 OLES
pyd el il il gl Soled b s s “Create Schematic” (g4 S (555 » 43,8 @ls | sl plas 4S5
S 4 B ass SIS L gs ccl sl 03ls (ioled SHb ojso 4 45 RS o S) p MlS e e Rl 8 pl o
SIS L g g 03 K blo | SSlad 0V S Gamio 1385 S Gus » S| oeimmen 253 o3l OLES 5580

Al sl ol Sled 4 8355 Sy 4 g 25 OF S

Create Technology Schematic

1) Select items you want on the schematic from the "Available Elements” list and move them to the "Selected Elements” list
- Use the Fiiter control to filter the “Available Elements” list by name
2) Press the "Create Schematic” button to generate a schematic view using the items in the "Selected Elements” list

Available Elements Selected Elements
5 g ful_adder_vhdl_code O A_BUF
- 7 Primitives D Cout
O A_IBUF <~ Remove =+ Cout_OBUF
|q » B_IBUF
=y (n \BUF <<~ Remove All

D Cout_OBUF

D Coutl

D S_OBUF

D sl
-7 Signals
-7 Top Level Ports

v Fiter Create Schematic_

[m|

Full_Addecvhd > Design Summary (Synthesized) i full_sdder_vhdl_code.nge %]
—
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33 eSS e 0l el e 5 es S S L g (Yo IS8 ) dul b go 2 5o “Implement Design” (e ;S

Aol O o

P | ¥ NoProcesses Running

Processes: full_adder_vhdl_code - gate_level
) > Design Summary/Reports
¥ Design Utilities
+ User Constraints
+ ()Q Synthesize - XST
# F)  Implement Design <
)  Generate Programming File

‘@  Configure Target Device
€%  Analyze Design Using ChipScope
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Design «+08 x
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I I\"e\'-': Q Implementation (@) @ Simulation
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Ej Behavioral ~
3‘5| Hierarchy
=] Full_Adder

o | B 3 xcbsix9-2tqgl44
= + Full_Adder_tb - behavior (Full_Add|
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HDLCompiler:806 - "E SE_Projects/Ful Adder/Ful
HDLCompiler:806 - "E:/ISE Prodjects/Full Adder/Full
ProjectMgmt - 4 error(s) found while parsing design

b.vhd"™ Line 80: Syntax error near "<".
i" Line 93: Syntax error near "<".

<
[E] consce @ Erors A\ Wamings (@ Findin Fies Results

oS mazrpled Jssle sl n Ll 5 L g S5 50 s a0l sl Ji.lL»ﬂJiléJ; sy s slalles VY ISS

S Soso 53 el Gl Lb s celo I v sbal & by e oS axkd HI85 50 A5 dallast ol 5 gy Lo
5 el atld 1l 5 5 S5 Sppe 4 el gy il Cole JBK s b3l I s Jsle
b R S oo 53 Ll CIKLCIOCK wlie slapb b placs s sl 2) b ls dals sy Jalasl 0 55 ol
Juj...» bl Pl Y MQ.OL«: dhi.:...» 44.19);]& LSLA.\S‘\.&]G_;.LLL ‘(aJ,,S(jp-‘an.? JALA)ML!C‘_,&LN Q)ﬁ Asle

S Gl Jziuj&u;\\)ﬁ,- GladS walas SIS ol gl

---First One---
constant <clock> period : time := 10 ns;
---Second One---
<clock> process :process
begin
<clock> <= '0';
wait for <clock>_period/2;
<clock> <= '1';

wait for <clock> period/2;
end process;

---Third One---

wait for <clock>_period*10;

T S8 SS Gl b S 5 il it sle b b3l LB e oxd 55 B e plndl 51
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P | FQ No Processes Running
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